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FOREWORD

This User's Primer provides installatio~ and operation guidelines for the BRI-STARS (Bridge
Stream Tube model for Alluvial River Simulation) model and a briefdescription of the model
capabilities. This primer is intended to assist users in applying version 5.0 ofthe BRI-STARS
model and was developed as a stripped down version ofthe User's Manual to facilitate training
exercises. This primer also provides instructions for use ofutility programs included with the
BRI-STARS model. BRI-STARS will be of interest to hydraulic engineers, bridge engineers, and
geologists involved in bridge scour evaluations and modeling ofgeneral scour in alluvial streams
in the vicinity ofbridge crossings and highway encroachments. BRI-STARS is especially useful
for sites where contraction scour and/or effects of in-stream mining activities are major concerns.
This primer as an electronic document along with the down-Ioadable BRI-STARS software is
available through the FHWA Bridge Technology web site at www.jhwa.dot.gov/bridge or through
the Hydrau-Tech, Inc. web site at www.hydrau-tech.com.
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• I •
APPROXIMATE CONVERSIONS TO SI UNITS APPROXIMATE CONVERSIONS FROM SI UNITS

Symbol When You Know Multiply By To Find Symbol Symbol When You Know Multiply By To Find Symbol

LENGTH LENGTH
in inches 25.4 millimeters mm mm millimeters 0.039 inches in
ft feet 0.305 meters m m meters 3.28 feet ft
yd yards 0.914 meters m m meters 1.09 yards yd
mi miles 1.61 kilometers km km kilometers 0.621 miles mi

AREA AREA

in2 square inches 645.2 square millimeters mm2 mm2 square millimeters 0.0016 square inches in2

ft2 square feet 0.093 square meters m2 m2 square meters 10.764 square feet ft2
yrP square yards 0.836 square meters m2 m2 square meters 1.195 square yards yrP
ac aaas 0.405 hectares ha ha hectares 2.47 acres ac
mP square miles 2.59 square kilometers km2 km2 square kilometers 0.386 square miles mi2

VOLUME VOLUME

f10z fluidounces 29.57 milliliters mL mL milliliters 0.034 fluid ounces f10z...... III...... gal gallons 3.785 liters L L liters 0.264 gallons gal
It' cubic feet 0.028 cubic meters m3 m3 cubic meters 35.71 cubic feet ft'
yd' cubic yards 0.765 cubic meters m3 m3 cubic meters 1.307 cubic yards yd'

NOTE: Volumes greater than 1000 I shall be shown in m3•

MASS MASS

oz ounces 28.35 grams g g grams 0.035 ounces oz
Ib pounds ·0.454 kilograms kg kg kilograms 2.202 pounds Ib
T short tons (2000 Ib) 0.907 megagrams Mg Mg megagrams 1.103 short tons (2000 Ib) T

(or "metric ton") (or or) (or "to) (or "metric ton")

TEMPERATURE (exact) TEMPERATURE (exact)

of Fahrenheit 5(F-32)19 Celcius °C °C Celcius 1.8C + 32 Fahrenheit of
temperature or (F-32)11.8 temperature temperature temperature

ILLUMINATION ILLUMINATION

fc foot-eandles 10.76 lux Ix Ix lux 0.0929 foot-eandles fc
fI foot-Lamberts 3.426 candela/m2 cdlm2 cdlm2 candela/m2 0.2919 foot-Lamberts fI

FORCE and PRESSURE or STRESS FORCE and PRESSURE or STRESS

Ibf poundforce 4.45 newtons N N newtons 0.225 poundforce Ibf
Ibflint poundforce per 6.89 kilopascals kPa kPa kilopascals 0.145 poundforce per Ibflin2

square inch square inch

• SI is the symbol for the International System of Units. Appropriate (Revised September 1993)
rounding should be made to comply with Section 4 of ASTM E380.
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1. GENERAL MODEL INFORMATION

1.1 INTRODUCTION

There is a need for a generalized water and sediment-routing computer model for
solving complicated river engineering problems with limited data and resources. This
program should have the following capabilities:

• To compute hydraulic parameters for open channels with fixed as well as
alluvial boundaries.

• To compute water surface profiles for subcritical, supercritical, and
combinations of both flows without interruption.

• To compute and simulate the hydraulic and sediment conditions in the
longitudinal and lateral directions.

• To compute and simulate the change of alluvial channel profile and
geometry regardless of whether the channel width is variable or fixed.

• To compute the alluvial channel changes in the presence of highway
encroachments and/or other man-made or natural structures.

• To compute channel changes in the presence of heavily sediment-laden
flows.

• To compute bank failures due to the sediment activity in the presence of
severe erosion problems.

Most of the sediment and water routing models, such as the HEC-6, were developed
for solving simplified one-dimensional alluvial river problems. Although there are
some truly two- or three-dimensional models, they require extensive amounts of
computer time and data for calibration. Thus, truly two- or three-dimensional models
may not be desirable for solving engineering problems with limited data and
resources.

The development of SRI-STARS (BRidge Stream Tube model for Alluvial River
Simulation) consisted of three stages. The development of a stream tube model for
alluvial channels with fixed width by Molinas was documented earlier. That model was
successfully applied to simulate local scour and deposition processes at the
Mississippi River Lock and Dam No. 26 replacement site near St. Louis. In the second
stage of development, the theory of minimum rate of energydissipation or its simplified
version of minimum total stream power was used to incorporate the channel width as
an unknown variable. Finally, in the last stage, the bridge hydraulics and local pier
scour component was added. Also, in this third stage, the model's capabilities were
enhanced by the inclusion of new sediment transport equations, graphical user
interface, lateral water, and sediment inflow options. Both energy and momentum
functions are used in the SRI-STARS model so the water surface profile computation
can be carried out through combinations of subcritical and supercritical flows without
interruption. The stream tube concept is used for hydraulic computations in a semi
two-dimensional way. Once the hydraulic parameters in each stream tube are
computed, the scour or deposition in each stream tube determined bysediment routing
will give the variation of channel geometry in the vertical direction.
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SRI-STARS is flexible in its application. When only one stream tube is used, it
becomes a one-dimensional model. When the sediment-routing subroutine is not
used, it becomes a model for fixed-bed hydraulic computation. When the
minimization subroutine is not used, it becomes a model forfixed-channel width. The
selection of number of stream tubes and different combinations of subroutines
depends on the site-speCific conditions, and an engineer's understanding and
interpretation of the fluvial processes.

1.2 GENERAL DESCRIPTION OF THE MODEL

The first major component of SRI-STARS is based on a stream tube computer
model with fixed-channel width to simulate streambed variations in rivers for which
sediment and hydraulic data are limited. Using stream tubes allows the lateral and
longitudinal variation of hydraulic conditions as well as sediment activity at various
cross sections along the study reach. The objective of the model is to study
complicated sedimentation problems for which there is interaction between the
flowing water-sediment mixture and the alluvial river channel boundaries. In order
to accomplish this purpose, the water surface profile and other hydraulic variable
computations for supercritical, subcritical, and the combination of both flow
conditions must be carried out without interruption. The bed armoring and the
breaking of the armor layer is incorporated to study longer periods of flow durations.

The stream tube computer program is a semi-two-dimensional program with the third
dimension, depth, being intrinsically incorporated into the computations. As such, it
has the basic limitations of every two-dimensional program; secondary flows cannot
be simulated. The channel is divided into a preselected number of tubes. The bed
elevation in each stream tube is allowed to move vertically up or down, depending
on the flow conditions. As a result, while one section of channel is eroding, another
section might be aggrading. Depending on the number of stream tubes to be used,
the channel cross section changes are averaged across different channel
subsections of varying widths. Since the computer time and space are directly
related to the number of stream tubes to be used, the user is required to decide on
the optimum number of tubes. Bed forms are not simulated due to the lack of a
generally accepted methodology for determining them. Even though provisions are
made to expand the program to include river confluences and middle islands, at this
point these options are not available. The channel boundaries are fixed in the lateral
direction and formation of meander bends cannot be simulated.

The computer model using stream tubes can be applied to a variety of river
problems. It can be used as a fixed-bed model to compute water surface profiles for
subcritical, supercritical, or the combination of both flow conditions involving
hydraulic jumps. This option allows the use of applications involving the computation
of water surface profiles in man-made channels with clear water, flow profiles over
spillways, or flow profiles in natural river channels where the interaction between the
sediment-water mixture and the channel bed are negligible. As a movable bed
model, the computer program can be applied to route water and sediment through
natural river channels. The use of stream tubes allows the variation of hydraulic
conditions and sediment activity not only in the longitudinal, but also in the lateral
direction. With the selection of a single stream tube, the model becomes one
dimensional. Average channel response to changes in certain riverflow or sediment
conditions can be studied. With the selection of multiple stream tubes, the model
becomes two-dimensional. The changes in the cross section geometries in the
lateral direction can be simulated. Since the bed elevation changes are not averaged
over the entire active channel widths as in one-dimensional models, more realistic
channel erosion or aggradation can be simulated. This option provides valuable

2
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information where certain navigation depths have to be maintained. It can also be
used in bank stability problems to identify expected regions of bank instabilities. The
armoring process provided in the program allows study of river sedimentation
problems for longer periods of time.

The stream tube computer model for routing water and sediment is composed of
three computational blocks: (1) backwater computations, (2) stream tube
computations, and (3) sediment routing computations. These computational blocks
are linked together during the operation of the model.

At each time step, first, backwater computations are carried out for the entire reach
with the channel treated as a single tube. Second, with the computed water surface
elevations, lateral locations of stream tubes at each cross section are determined.
With each stream tube treated as an independent channel, the hydraulic variables
along it are computed. Third, sediment is routed through each stream tube satisfying
the sediment continuity equation. At the end of these computations, bed material
compositions are revised and channel bed elevations are updated. An armoring
procedure is incorporated into the sediment routing computations. Computations
proceed according to the above format in time steps throughout the entire defined
water and sediment discharge hydrographs.

The second major component of BRI-STARS is a variable width stream tube model.
BRI-STARS can be used for decisions as to whether the channel adjustments taking
place at a given cross section due to scouring/deposition should advance in the
lateral or vertical directions.

The basic tool for this decision-making component is the Minimum Rate of Energy
Dissipation Theory developed by Yang and Song (1979, 1986) and Song and Yang
(1979, 1980, 1982a, 1982b), and this general theory's special case, Minimum
Stream Power Theory used by Chang (1980b).

The Minimum Stream Power Theory states that

For all alluvial channels, the necessary and sufficient condition of
equilibrium occurs when the stream power per unit length of
channel, yQS, is a minimum subject to given constraints. Hence, an
alluvial channel, with water discharge Q and sediment load Qs as
independent variables, tends to establish its width, depth, andslope
such that yQS is a minimum.

To extend the minimization procedure to channel reaches experiencing gradually
varied flows, stream power (yQS) should be integrated along the channel.

In BRI-STARS, selecting directions for channel adjustments is accomplished by this
integral expression being minimized for total stream power at different stations. At
a given time step, if alteration of the channel widths results in lower total stream
power than raising or lowering of the channel, channel adjustments are progressed
in the lateral direction. For the opposite case, the adjustments are made in the
vertical direction.

At cross sections where sediment erosion is predicted following the sediment routing
procedure, channel adjustments can proceed in either deepening or widening
directions. The selected mode of channel adjustment in the computer model is the
one resulting in the minimum total stream power for the reach.

Similarly, at cross sections where sediment accumulation is predicted, channel

3
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adjustments can proceed in raising the bed by sediment deposition on the bed or
along the banks. The selected mode of channel adjustment in BRI-STARS is the
one resulting in the minimum total stream power for the reach. In both the aggrading
and degrading channel cases, the sediment load is treated as a constriction in the
minimization. In cases where geological or man-made restrictions are applied to the
channel deepening or widening processes, computations are performed to
accommodate these constrictions.

The amount of channel width adjustment during a time step is determined by the
sediment continuity equation. However, for channel widening or narrowing
computations, the wetted perimeter P is replaced by the hydraulic radius R. Channel
widening of narrowing computations are carried out in the usual way using the
sediment continuity equation. The amount of sediment eroded from the banks from
a given reach is added into the sediment loads entering that reach in sediment
routing computations. This sediment load becomes influx for the down stream
sections that follow to conserve the mass balance.

Finally, the third component of BRI-STARS allows the computation of the hydraulic
flow variables and the resulting scour due to highway bridge encroachments. BRI
STARS performs bridge hydraulics computations utilizing the FHWA's WSPRO
water surface profile computation program routines. The details of these
computations are described in detail in the WSPRO User's Manual. Also, a second
option which utilizes user supplied local loss coefficients at the bridge sections is
available. In this simple bridge approach, the bridge loss coefficients can be
calibrated with measured/computed water surface profiles for closer agreement with
more accurate methods of computations. The simple bridge approach is applicable
only for free-surface bridge hydraulics computations since it treats the bridge piers
as a part of the channel geometry.

The local scour due to bridge piers in the BRI-STARS model is computed utilizing
the following methods:

1. Colorado State University/FHWA HEC-18 equation.

2. Jain and Fisher equation.

3. Laursen equation.

4. Froehlich equations.

5. User-supplied generic equation.

The local scour due to abutments in the BRI-STARS model is computed utilizing the
following methods:

1. Colorado State University equation.

2. Laursen equation for clear-water scour.

3. Laursen equation for live-bed scour.

4. Froehlich equation for clear-water scour.

5. Froehlich equation for live-bed scour.

The model computes and lists the local scour at bridge piers and abutments
separately from the computed general stream aggradation/degradation values. The
maximum potential local scour value computed during the simulation event is
computed and used in the final estimation of cumulative scour at bridge sites. The
BRI-STARS model also computes the potential contraction scour utilizing Laursen's
simplified contraction scour equation and provides users this information for

4
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comparison purposes.

1.3 POTENTIAL APPLICATIONS OF SRI-STARS

Potential applications of the SRI-STARS can be summarized as follows:

a) The model can be used as a fixed-bed model to compute water surface
profiles for subcritical, supercritical, or the combination of both flow
conditions involving hydraulic jumps. These computations include but are
not limited to:

• Flow profiles in man-made channels with no sediment.

• Flow profiles over spillways and waterways.

• Water surface profiles in rivers where bed elevation changes are
negligible.

b) The model can be used as a movable bed model to route water and
sediment through alluvial channels.

c) The use of stream tubes allows the model to compute the variation of
hydraulic conditions and sediment activity not only in the longitudinal but
also in the lateral direction.

d) With the selection of a single stream tube, the model becomes one
dimensional. Byselection of multiple stream tubes, changes in cross section
geometries in the lateral direction can be simulated.

e) The armoring option allows simulation of longer term riverbed changes.

f) With the selection of the minimization procedure option, the model can
simulate channel widening and narrowing processes.

g) With the selection of the WSPRO bridge hydraulics option, the model
utilizes specialized routines for the computation of flows through highway
bridge openings.

h) Maximum potential bridge pier scour for given flood hydrographs are
computed through the use of several equations for various pier geometries.

i) Flow diversion problems can be studied through the use of lateral
inflow/outflow options.

j) Aggregate mining studies can be conducted by simulating various mining
alternatives (quantity and physical location).

k) Dredging studies can be conducted by the use of the lateral sediment
outflow option without any water outflow.

I) Bank failures with known rates of bank regression can be simulated through
the option of lateral sediment inflow without water inflow.

5
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2. SRI-STARS PACKAGE

2.1 CONTENTS OF THE SRI-STARS PACKAGE

The package includes:

1) BRI-STARS User's Manual.

2) Two 3-1/2 inch MS-DOS formatted high-density floppy disks containing:

• Program Files:

BST50.EXE - interactive data entry module for BRI·STARS.
BSTPLOT.EXE - visual display program for BRI-STARS-generated thalweg

and water surface profile output.
BSTXSEC.EXE - conversion program for BRI-STARS-generated cross

section output files to Corel Quattro-Pro-compatible
format for the purpose of hard-copy plotting.

NPPLUS.EXE - Notepad Plus for Windows Text Editor for the integrated
development environment.

• Resource Files:

BRISTARS.RSC - Default file names for BRISTARS.
BSTPLOT.RSC - Default file name for BSTPLOT.
BSTXSECT.RSC - Default file name for BSTXSECT.
BSTPLOT.WSP - Default demo file for BSTPLOT.

• Title Screen Files:

BSTIMAGE.SYS - Title screen file for BRI-STARS.
BSTPLOT.SYS - Title screen file for BSTPLOT.
BSTXSECT.SYS - Title screen file for BSTXSECT.

• Help Files:

BSTHELP.HLP - BRI·STARS help file.
BSTHELP.CNT - Contents file for BSTHELP.
BSTTHALW.BMP - Bitmap image used in help file.
BSTTOPO.BMP - Bitmap image used in help file.
BSTTUBES.BMP - Bitmap image used in help file.
BSTCONTNTS.BMP - Bitmap image used in help file.

• Examples:

EXMPL001.DAT - example problem 1 data file.
EXMPL002.DAT - example problem 2 data file.
WSPRO.DAT - WSPRO data used in conjunction with EXMPL002.DAT.
EXMPL003.DAT - example problem 3 data file.
EXMPL004.DAT - example problem 4 data file.
EXMPL005.DAT - example problem 5 data file.
EXMPL006.DAT - example problem 6 data file.
EXMPL007.DAT - example problem 7 data file.
EXMPL008.DAT - example problem 8 data file.
EXMPL009.DAT - example problem 9 data file.
EXMPL010.DAT - example problem 10 data file.

7
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• BSTEMPLT Corel Quattro-Pro Worksheet Utility Files:

BSTEMPLT.WB2 - Input Data Generator Template for SRI-STARS.
15INPUTH.WB2 - Input Data Generator Template for EXMPL009.DAT.
BSTGEN.EXE - Quattro PRO-to-BRISTARS data translator program.

2.2 ORGANIZATION OF THE PACKAGE

Organization of the SRI-STARS package is illustrated below:

·,-;}s,!,>,~,··,,·_,: _....""'::''"'-:',,, '--':'j;.

~I~.i~~~jt
Windows 95

Program

~;1(~~BST~;Met:"!WBC2"(i Preprocessor
.2~BStGEN!EXE Programs

Main
Program

Postprocessor
Programs

Figure 1. Organization of SRI-STARS package.

2.3 TYPOGRAPHICAL CONVENTIONS

Throughout this User's Primer, when you see Enter you should press the Enter key
(which is also called the Return key).

In the description of procedures, the items to be typed by the user are shown in
upper case lettering. These commands can also be typed in any combination of
upper and lower case lettering.

Throughout the User's Primer the computer hard disk is always assumed to be drive
C. Drives A: and B: are assumed to be floppy disk drives.

In the explanations pertaining to output generation, it is assumed that the printing
device is properly connected to the microcomputer and that the device driver for a
plotting device is successfully installed forthe plotting package. The user is expected
to follow manufacturer's instructions in operating the printing devices to activate
appropriate internal printing styles.

8



BRI-STARS USER'S PRIMER

2.4 SYSTEM REQUIREMENTS

The system requirements for running the BRI-STARS model on a microcomputer
are:

• 16 MB main memory (32 MB recommended).

• Intel Pentium 66 Mhz or higher microcomputer.

• Windows 95 Operating system.

• Super VGA (800x600 at 256 color) or higher resolution screen for displaying
computed plots.

• Graphics printer such as HP LaserJet Series II or better.

• Hard disk with enough room to hold the program, utilities, examples, and
output files (Allow at least 10 Megabytes of hard disk space for
applications) .

9
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3. INSTALLATION

To install SRI-STARS on the hard disk, use the automatic Windows 95/NT setup
program provided on Diskette 1. The SETUP program is a utility program which
automates the installation of SRI-STARS by creating a program and examples
directory on the hard disk and by automatically copying the SRI-STARS model, utility
programs, example problem input data, and output files contained in Diskettes 1-2
provided with the package.

1) To run the SETUP program place the Disk 1 into floppy drive A. From the
main Windows 95 frame select START and then RUN options. Type
A:\SETUP and then press the Enter key.

2) A welcoming message describing the purpose of the program will be
displayed. To continue with the installation press the Next key.

3) At this point, the program licensing screen will be displayed. To continue
with the installation, press the Next button.

4) The user information screen requests user's name and affiliation. To
continue with the installation press the Next button.

5) The Destination Location Window requests the installation directory. To
accept the default directory of C:\SSTWIN95, press the Next button. To
change the directory name, press the Browse button and enter directory
name in the Path line. If the directory does not exist, it will be automatically
created.

6) The Program Folder Window requests the name of the program folder the
SRI-STARS program is placed into. To accept the default folder name of
SRI-STARS, press the Next button. Otherwise enter a new name. If the
folder does not exist, it will be automatically created.

7) Confirmation Window requests the confirmation of installation information
entered by the user. To confirm, press the Next button. To change the
information, press the Change button and reenter information.

8) At this point the installation program copies all files into the specified SRI
STARS directory and prompts the user to complete installation by pressing
the Finished button.

At this point the BRI-STARS program group is created and the BST50 icon is placed
in the program group. To run the program, double click this icon.

11
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4. OPERATION OF THE MODEL

The logical steps followed in the operation of the model can be listed as:

• Input data preparation.

• Execution of the model.

• Generating output:

- Computed formatted output.
- Cross section profile output.
- Water surface elevation and hydraulic output.

4.1 INPUT DATA FILE PREPARATION

The BRI-STARS model operates in a batch mode in which the data needed by the
model is provided through a separate data file. This data file can be prepared in
several ways. They are:

• Using an ASCII text editor (such as Wordpad provided with Windows 95 or
the Notepad Plus included in the BRI-STARS package) and by following
the guidelines provided in chapter 6 for hydraulic data, chapter 7 for
sediment data, chapter 8 for bridge scour data, and chapter 9 for
minimization procedure data.

• By modifying an example problem provided in the package using an ASCII
text editor.

• Using the BSTEMPLT.WB2 template worksheet provided with the BRI
STARS package with Corel Quattro Pro for Windows.

• Using the BSTDATA data entry program provided with the earlier DOS
version of the model.

4.2 EXECUTION OF THE MODEL

After a successful installation, the executable BRI-STARS model and the utility
programs are downloaded either into the C:\BSTWIN95 directory on the hard disk
or into a directory defined by the user. The example data files are also copied into
the same directory.

In order to run the model, two procedures can be followed. The first procedure
involves the use of the main Windows 95 frame, and the second procedure uses the
Windows Explorer program.

Method 1-Run BRI-STARS from the main Window:
1) Select Start and then Programs.

2) Point to the BRI-STARS program group from the program list.

3) Double click on the BST50 icon.

13
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Method 2-Run BRI-STARS Using Windows Explorer:
1) Select the directory in which BST50 is located.
2) Highlight BST50.EXE from the list of files.
3) Double click on the BST50 icon.

Once the BRI-STARS model is activated, an opening screen with program
information is presented. To run BRI-STARS with the EXMPL009.DAT file, the
following procedure is suggested:

1) Select File from the main menu.

2) Specify the input file name by selecting Input from the drop-down menu and
then by entering the desired file name (EXMPL009.DAT). Users may also
browse through the directory tree using the standard Windows style file
browsing utility, and may select other files by highlighting desired files.

3) Specify names for other file menu items:

• Output File - file containing results.

• X-Secs File - file containing cross sections output.

• WSP File - water surface and thalweg elevations output.

• Messages File - file containing miscellaneous messages during
execution.

By default, BRI-STARS uses the user-supplied input file name with .OUT,
.XSC, .WSP, .MSG extensions for naming these files. If these defaults are
acceptable, move to next step.

4) Select Run from the main BRI-STARS menu.

5) Observe screen output:

• Observe thalweg and water surface elevation changes.

• Observe stream tubes and velocity distributions.

• Observe topographic changes during simulation.

6) If results are acceptable, generate output for reporting results.

7) Otherwise, edit the input file by selecting Edit/Input File from the main BRI
STARS menu and repeat steps 4-6.

8) Continue until satisfactory results are obtained.

At the end of the BRI-STARS run described above, if the plotting option is requested
for generating water surface profile plots and/or change cross section plots, two data
files will be created containing plotting information. The default names for plot data
files are XSECTS.XSC and WSPROFS.WSP. The file XSECTS.XSC contains the
channel cross section information at each simulation time step, and
WSPROFS.WSP contains the water surface profile information. In order to secure
these files for future use and to provide proper identification, the user is urged to
save these files under different names at run time by specifying unique file
identification.

The procedure outlined above can be modified for different applications by altering
the names of input and output data files. Since some of the output generated by the
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model could be very large, the use of floppy drives A: and B: for routing the output
from long runs is not recommended. The user should ensure that there is enough
storage space on the hard disk for the output (should allow 1-2 Megabytes of hard
disk space for IPRLVL=O for 100 time steps). As a good practice, the user is
encouraged to create separate directories for different applications and save the
output of each application in these individualized directories.

4.3 GENERATING OUTPUT

At the end of model execution, SRI-STARS results are stored in several output files.
These files can be imported into a variety of commonly available word processors,
desktop publishing programs, and spreadsheet and/or graphics packages for
presenting results with varying levels of sophistication. In general:

1) Import the ASCII formatted output file (OUTPUT.OUT) into a word
processor to enhance the formatting of the document.

2) Use the post-processor program BSTXSECT provided with the SRI-STARS
package to manipulate the unformatted Cross Section Output
(XSECTS.XSC) file. The BSTXSECT output can be used in conjunction with
a variety of plotting/spreadsheet packages to generate report quality cross
section plots at various simulation time steps.

3) Import the ASCII formatted Water Surface and Thalweg Profile Output
(WSPROFS.WSP) file into a spreadsheet or graphics program to generate
tabulated profiles and water surface profile plots.

4.3.1 Formatted Numeric Output

The procedure for generating an output file from successful SRI-STARS run is
described in the previous section. This output file can be routed to various dot matrix
or laser printers for obtaining hardcopy printouts.

Most printers, as a default, operate using a fixed-width font on an 80-column page
width in "portrait" orientation setting. SRI-STARS utilizes this default setting to format
the printouts resulting from sediment routing applications involving up to 5 sediment
size groups. For applications involving more than five sediment size groups, to obtain
a legible output, a landscape (sideways) font or a 16.6-characters-per-inch
compressed font should be used. The compressed and landscape fonts are
available in HP LaserJet Series WM internally. Additionally, by importing the ASCII
SRI-STARS output into word processor and by using a fixed-width font (such as
Letter Gothic or Courier), users may utilize other text enhancements such as bolding,
graphic lines, etc.

4.3.2 Cross Section Profile Plots

In order to improve SRI-STARS' plotting capacity, a simple approach is taken. In this
approach, the model results which are stored in the file XSECTS.XSC are
transferred into a format compatible with widely used microcomputer graphics
packages.
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Step 1 Run the utility program BSTXSEC to convert the format of the cross section
output file which is generated by BRI-STARS into spreadsheet program
compatible format. The assigned file name for the intermediate file is
XSECTS.PRN to follow common file naming conventions.

Step 2 Import XSECTS.PRN into Quattro Pro for Windows or other spreadsheet
programs, and create a graph.

Step 3 Generate hardcopy printouts through the spreadsheet or graphics programs.

4.3.3 Water Surface Profile Plots

In order to generate water surface profile plots to display BRI-STARS results, a
simple procedure is followed. In this procedure, the Water Surface and Bottom
Elevations Profile file which is generated at the end of the BRI-STARS run is
imported into a spreadsheet program as an ASCII numeric file.

To create water surface plots following a successful BRI-STARS run, the following
two-step procedure is needed.

Step 1 Import a copy of WSPROFS.WSP generated as an output into a
spreadsheet programs, and create an X-V graph.

Step 2 Enhance and print the graph utilizing the graphics tools.
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5. VISUAL OUTPUT FROM SRI-STARS

SRI-STARS visual output can be observed in the following screen windows:

1) Thalweg profile window.

2) Stream tubes and velocities window.

3) Topographic changes window.

5.1 THALWEG AND WATER SURFACE PROFILE WINDOW

In a mainframe, thalweg and water surface profile window displays the INITIAL
(green line) and the CURRENT (red line) thalweg profiles. In this main plot, the
computed water surface profile is indicated by a blue line. In the three vertically
stacked minor frames, cross sections are displayed at user selected stations. In the
cross section plots, the starting bottom elevations are identified by a green line and
the current bottom elevations are shown by a red line. Depending on user options,
the water surface line is omitted, shown as a blue line, or shown as a fill. The vertical
and horizontal viewing limits of cross sections and the water surface profile viewing
boundaries are specified in the PV record.

ST"" NO. .,1

STA NO. 'f'5'!

"" .• --:::-=-''------..=-:,,,:-',

•,<XX>

00:86.-58

.'.
\

t'\.-.,

T~~ sty;.p Nc," 00'3'3 ;Z;Z ,.; >;;c!'J'J'P1Q-tQ

T"~ EF""PJ',..d.. OO.. 'f'O."!S3

.=,,1>=--------------,

...... , '--------------=-'

Figure 2. Thalweg and water surface profile window.
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5.2 VELOCITIES AND STREAM TUBES WINDOW

In a mainframe, the velocities and stream tubes window displays the current stream
tube boundaries. The color-coded contours show computed velocities in a reach by
laterally and longitudinally interpolating stream tube velocities. In the three vertically
stacked minorframes, discharge hydrographs at stations specified in the PV records
are given. The upstream and downstream reach boundaries for screen viewing are
controlled by the PV record.

STA NO. "/"/

STREAM TUBES AND VELOCITIES
C.O 16.0

144.00

STA NO. "/3

STA NO. "/2

4B~U5.

00:42:"19

2150.

Time Left :

Time Step No: 0023 "/5 % Complete

Time Elapsed: 00:08:02 • ---'

140&. ,..---------

Figure 3. Velocities and stream tubes window.

5.3 TOPOGRAPHIC CHANGES WINDOW

In a mainframe, the topographic changes window displays cumulative bed elevation
changes up to the current simulation time step. The color-coded bed elevation
change contours show computed scour/deposition at various longitudinal and lateral
locations in the study reach. Stream tube boundaries are superimposed onto the
screen plots to indicate location of the main flow channel. In the three vertically
stacked minor frames, bed-material size distributions are given at selected stations.
Upstream and downstream reach boundaries and the stations for discharge
hydrograph viewing are controlled by the PV record.
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STA NO. ~~

STA NO. ~3
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STA NO. ~2

·e.o
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Figure 4. Topographic changes window.
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6. ORDER OF BRI-STARS RECORDS

The BRI-STARS data file consists of a logical sequence of groups of data. These
groups are:

• Title information.

• Channel geometry.

• Roughness.

• Energy losses.

• Stream tube.

• Hydrologic information.

• Hydraulic boundary conditions.

• Sediment transport.

• Pier, abutment, and contraction scour.

• Printout.

• Streampower minimization.

In general, BRI-STARS data files contain the following records in the order listed
below:
• Title Information Records:

TT Title Records.

• Geometric Data Records:

NS Number of Sections.
ST Station.
NO Number of Sub-Division.
GP Global Positioning.
XS Cross Section.

• Roughness Data Records:

RN Roughness Equation.
RH (or RB) Roughness Values/Break Points.

• Energy Losses Data Records:

CL Coefficients of Local Losses Record.
CE Coefficients of Expansion/Contraction Energy Losses.

• Bottom Elevations Data Records:

CB Channel Bottom.

• Stream Tubes and Flow Distribution Data Records:

NT Number of Stream Tubes Record.

• Hydrologic and Time Step Data Records:

IT Number of Iterations Record.
QQ Discharge Record.
SS Stage Record.
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TL Station Identification for Stage-Discharge Table Record.
SQ Stage-Discharge Table Record.
DO Discretized Discharge Record.

RC Rating Curve Record.

TQ Table of Discharge Record.

QL Lateral Water Inflow Record.

• Sediment Data Records:

SO Sediment Transport Option Record.

as Sediment Discharge Record.

SE Sediment Transport Equation Record.

TM Water Temperature Record.

SF Number of Size Fraction Record.

SG Sediment Size Groups Record.

SO Sediment Size Distribution Record.

S8 Sediment Size Breakpoint Record.

SX Size Distribution Across Channel Record.

SL Lateral Sediment Inflow Record.

• Bridge Scour Data:

PS Pier Stations Record.

PE Pier Scour Equation Record.

PP Pier Scour Parameters Record.

PC Pier Equation Coefficient Record.

• Screen Output Records:

PV Visual Screen Output Record.

• Output File Generation Records:

PR Printout Record.

PL Plotting Option Record.

PX Channel Cross Section Plotting Record.

PW Water Surface Profile Plotting Record.

• Minimization Data Records:

MN Minimization Option Record.

MI Minimization Iterations Record.

MR Bed Elevation/Width Variation Record.
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7. DATA NEEDS FOR SRI-STARS

In order to generate a data file for a BRI-STARS simulation, the following data is
needed:

• Title Information.

• Geometric Data.

• Hydraulic Data.

• Roughness Data.

• Bottom Elevations Data.

• Energy Losses Data (Optional).

• Stream Tubes and Flow Distribution Data.

• Computational Time Step Data.

• Stage-Discharge Data.

• Sediment Data (Optional).

• Sediment Equation.

• Sediment Inflow Hydrograph.

• Sediment Size Data.

• Bridge Scour Data (Optional).

• Screen Output Control Data (Optional).

• Output File Control Data.

• Minimization Data (Optional).

In the absence of a data group, engineering analysis may be required to extrapolate
data from similar watersheds in the geographic region and/or estimations from
similar flows.
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8. BST-PLOT UTILITY PROGRAM

8.1 INTRODUCTION

The BST-PLOT (!2RI-STARS Water Surface Profile Plotting) utility program is used
to animate the water surface and bottom (thalweg) profiles computed by BRI
STARS. It can be activated at anytime during the execution of BRI-STARS to view
the current water surface profile output or an existing water surface output file
generated earlier. By plotting the water surface and bottom profiles with this utility,
the water and sediment routing processes can be quickly reviewed, and the
simulation results can be visualized.

Table 1. BST·PLOT main menu and its contents.

Menu Contents Explanation

File Input File Select a file for plotting

Run Start plotting water surface and bottom profiles

Stop Stop plotting

Goto Frame Go to a specified frame

Single Frame Advance Advance one frame

Single Frame Reverse Reverse one frame

Exit Exit SST-PLOT and go back to the BRI·STARS
main window

Edit Select All Select all contents shown on the screen

Select Graph Select graph by highlighting an area on the screen

Copy Copy the contents selected by "Select All" or ·Select
Graph" into buffer

Print Print the contents stored in the buffer

View Superimpose Bottom Prof. Superimpose bottom profile plots

Superimpose Surface Prof. Superimpose water surface profile plots

Grid On Show grid lines on the screen

Grid Off Do not show grid lines on the screen

Horizontal Axis Change the minimum, maximum, and incremental
values of horizontal axis

Vertical Axis Change the minimum, maximum, and incremental
values of vertical axis

Speed Slow Use slow speed to plot the profiles

Normal Use the default normal speed to plot the profiles

Fast Use fast speed to plot the profiles

Status Pause Pause the plotting

Window Full Screen Use full screen to show the profile plotting window

Status Bar Hide the status bar at the bottom of the window

Help About Information about the BRI·STARS Water Surface
Profile Plotting utility
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The menu bar in the SST-PLOT window uses pull-down menus accordance with
standard Windows applications. Each menu and its contents are explained in
table 1. The steps in using SST-PLOT utility program are given in the following.

8.2 STEPS IN USING BST-PLOT

Step 1 Activate the BST-PLOT utility program by choosing View from the main
menu of BRI-STARS and then choosing Animated WSPlThalweg Profs.

Step 2 BST-PLOT uses the current water surface and bottom profile output
generated by BRI-STARS as the default input file for viewing. Users can
select a different file to view by using Input File under File menu command.

Step 3 Choose Run under the File menu command to view the water and bottom
profiles for the selected file.

Step 4 Choose Exit under File menu command to exit BST-PLOT and to return
back to the main window of BRI-STARS.

8.3 OPTIONS FOR eST-PLOT

• To view a specified frame (time step). To view the water surface and
bottom profiles for a specified frame (time step), choose Goto Frame under
File menu, then specify the frame number in the "Goto Frame" dialog box.
Click "OK" to view the specified frame. If you click "Cancel," the operation
will be canceled.

• To view the water surface or bottom profiles one frame at a time. To
view the water surface or bottom profiles one frame at a time, you can use
the Single Frame Advance or Single Frame Reverse under the File
menu. This option will advance or reverse plots by a single frame.

• To superimpose the water surface or bottom profiles. The previous
water surface or bottom profile plots can be superimposed on the current
screen plot for viewing the changes from preview steps. Click on
Superimpose Bottom Prof. under the View menu to turn on or turn off the
superimposing of bottom profiles. Similarly, click on Superimpose Surface
Prof. under the View menu to turn on or turn off the superimposing of water
surface profiles. By default, superimposing bottom profiles is chosen.
Superimposing water surface profiles is not selected by default.

• To show or hide grids on the screen. Choose Grid On under the View
menu to show grids on the screen, and choose Grid Off under the View
menu to hide grids on the screen.

• To specify the view range. Choose Horizontal Axis under the View menu,
then enter the upstream, downstream, and incremental values of horizontal
axis in the "Horizontal Axis" dialog box. Click "OK" to change the horizontal
axis to the specified values for viewing. By clicking "Reset," you can set the
Horizontal Axis back to the default values determined bythe program. Clicking
"Cancel" cancels the operation. Similarly, choose Vertical Axis under the
View menu to change and specify the vertical range for viewing.
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• To change the plotting speed. You can change the plotting speed by
using Slow, Normal, and Fast under the View menu. By clicking on Normal
under the View menu, the plotting speed will be set to the normal speed,
which is the default speed when you activate the BST-PLOT window. To plot
the water su rface and bottom profiles with slower speed than current plotting
speed, choose Slow under the View menu. You can repeat click on Slow
under the View menu to reduce the plotting speed. Similarly, you can use
Fast under the View menu to increase the plotting speed. By repeating
clicking on Fast under the View menu, the plotting speed will increase
incrementally.

• To print the water surface or bottom profile plotting. Use Select All or
Select Graph under the Edit menu to select the range of plotting, and then
click Copy to copy the selected plotting to the buffer. Next, click on Print to
print the selected graph, or paste to other Window utilities, such as "MS
Paint," for editing.

• To use full screen plotting. Choose Full Screen under the Window menu
to show the plotting window using full screen. To hide the status bar at the
bottom of the plotting window, click on Status Bar under the Window
menu.

• To pause the plotting. To pause the plotting, click on Pause under Status
menu. Clicking on Resume resumes the window and continues the plotting.
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9. BST-XSECT UTILITY PROGRAM

9.1 INTRODUCTION

The BST-XSECT (.!2RI-STARS Cross Section Data Conversion) utility program is used
to convert the unformatted cross section profiles output computed by BRI-STARS into
series of x-y-z points for generating 2- and 3-dimensional cross section plots. This utility
can be activated from the main menu of BRI-STARS at the end of a simulation run by
first selecting the View option and then choosing the X-Sectn Data Conversion option
from the pull-down menu. By converting the unformatted data into tabulated "station
distance across channel-elevation" series of points, the model output can be used in a
variety of spreadsheet and graphics program to display the simulation results.

Table 2. BST-XSECT main menu and its contents

Menu Contents Explanation

File Input File Select a file for cross-section conversion

Run Start data conversion

Exit Exit SST-XSECT and go back to the SRI-STARS main
window

Edit Input File Use built-in Notepad Plus to view the unformatted cross
section file

Converted File Use built-in Notepad Plus to view the converted cross section
output file

Print Print the contents stored in the buffer

9.2 STEPS IN USING SST-XSECT

Step 1 Activate the BST-XSECT utility program by choosing View from the main
menu of BRI-STARS, and then choosing X-Sectn Data Conversion.

Step 2 BST-XSECT uses the current cross section profiles output generated by BRI
STARS as the default input file for conversion. Users can select a different file
for conversion by using Input File under the File menu command.

Step 3 Choose Run under the File menu command to activate the conversion process.

Step 4 Choose Exit under the File menu command to exit BST-XSECT and to
return back to the main window of BRI-STARS.

9.3 OPTIONS FOR BST-XSECT

• To generate cross-section profiles at a station at various time steps.
To generate a series of cross section profiles at a station, select (C)hoose
Parts when prompted if (E)ntire file or parts are to be converted. Specify
the station number when prompted, and depending on the graphics package
format, insert spaces between time steps.
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• To generate cross-section profiles at all stations at various time steps.
To generate a series of cross section profiles at all stations, when prompted,
select (E)ntire file.

• To edit (or view) the converted file. Select the Edit option from the main
menu, and then choose the Converted File from the pull-down menu.
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10. SRI-STARS QUATTRO PRO EDITOR

10.1 INTRODUCTION

The BSTEMPLT is a Quattro Pro worksheet with specially programmed macros
(sequences of commands which automate certain procedures) for editing and
entering BRI-STARS input data. The worksheet is color-coded with cell definitions
to facilitate data entry and manipulation. The macros provided in this worksheet
allow users to generate data entry templates automatically. By following the
instructions given for each cell, users can easily enter their data into the worksheet.
If the geometry data, hydrology data, and sediment data are already in a separate
worksheet file, these data can be imported into the current worksheet by the "cut
and-paste" facility provided by the Windows 95 environment. After entering the data
into the Quattro Pro worksheet, the information can be transferred into the BRI
STARS input data format automatically.

The "BSTEMPL.WB2" was developed in Corel Quattro Pro for Windows. In order to
use this worksheet, Quattro Pro V6.0 or later for Windows is required.

10.2 STEPS IN USING BSTEMPLT

As shown in figure 5, the three steps in using BSTEMPLTworksheet are: BUILDING
A TEMPLATE, ENTERING DATA, and GENERATING BRI-STARS INPUT FILE. In
the first step, using the built-in macros, a data entry template for the specific problem
is generated. This template reflects the basic layout of the data file with properly
ordered records. In the second step, the data for each cell in" the template is entered
manually. In the last step, following the data entry the spreadsheet information is
transferred into BRI-STARS input data format. The details of using BSTEMPLT are
given in the following.

BUILDING A TEMPLATE
IN QUATTRO PRO WORKSHEET

l'
ENTERING DATA

IN QUATTRO PRO WORKSHEET

"
GENERATING BRI-STARS
FORMAT INPUT DATA FILE

Figure 5. Steps in using BSTEMPLT.
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STEP 1. BUILDING A TEMPLATE

1. Get information about your data.

a) Unit system used in the data, Le., English units or metric units.

b) Cross-sectional data information, including the number of cross
sections and the number of data points at each cross section.

c) The number of discretized data values for the stage-discharge data.

d) The numberof discretized data values for the sediment discharge data.

e) The number of discretized data values for the water temperature data.

f) The number of sediment size groups.

As an example, the SRI-STARS input file generated through BSTEMPLT for 15
Bridge data is listed in Examples. The data information collected for this example
problem is given in the following.

(i) The unit system used in the example problem is English units.

(ii) Cross sectional data information, including the number of cross sections
and the number of data points at each cross section, is listed in table 3.

(iii) The number of discretized data values for the stage-discharge data is 144.

(iv) The sediment inflow discharge at upstream boundary is 300,000 tons/day
for 144 time steps.

(v) The water temperature is 55°F for 144 time steps.

(vi) The number of sediment size groups is 3.

Table 3. Cross sectional data information for 15 Bridge data.

No. of No. of No. of No. of No. of No. of
Cross Data Cross Data Cross Data

Sections Points Sections Points Sections Points
1 29 8 26 15 26
2 29 9 24 16 22
3 29 10 26 17 17
4 29 11 18 18 26
5 26 12 18 19 13
6 28 13 18 20 13
7 26 14 20 21 13

2. Open "BSTEMPLT.WB2" in Quattro Pro (Version 6.0 or later) for Windows
to start a new data entry task and save it under a different name. Leave the
original "BSTEMPLT.WB2" unchanged.

Note: For this step, the default startup macro \0 is needed. To check your
startup macro, you may right-click on the Corel Quattro Pro title bar and
choose Application Properties from the QuickMenu or pull down the Edit
menu and choose Preferences. The window titled Startup Macro in the
Macro tab displays the startup macro. This entry must be set to \0. If it is
not \0, modify the entry and reopen the "BSTEMPLT.WB2."
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Forexample, after "BSTEMPL T. WB2" is opened, you save itas "BSTINPUT. WB2".
From now on, you will work in the Ouattro Pro file "BSTINPUT. WB2".

3. Click the quick buttonI-_IIP-Atospecify the unit system. If
the unit system in cell B6 is already in the one you need, then you can skip
this step.

For the example problem, choose "English Unit System."

4. Move cursor down to the "NS" record line and enter the number of the cross
section. Then click on the quick buttonIIiBStt-_---'
to generate a cross sectional template for the specified number of cross
sections.

you enter 21. Then click on the
~=~=~~=~==~buttonandchoose "GENERATEANDADJUST

SECTION TEMPLA TE"; next choose 'USE SPECIFIED NO. OF SECTIONS: 21 ".
For slower computers, this step may take a while; you should wait until finished.

5. Move cursor to the "ST" record for cross section number 1, and enter the
number of data points. Then click on the quick button next to it to
automatically adjust the number of "XS" records, so that the number of "XS"
records matches the number of data points specified in "ST" record for
section 1. Before you use the quick button, make sure the cell showing
Number of Points at Station 1 is highlighted.

For the example problem, go to the cell requiring the number of data points for
cross section no. 1 and change the default value of 50 to 29.

6. Repeat step 5 for all cross sections to specify the number of data points and
adjust the number of "XS" records for each cross section.

For the example problem, you enter the number of data points given in table 3 for
other cross sections and adjust the number of 'XS" record using the quickbutton.

7. Move the cursor down to the "RH" record. Then click on the uick button
8i~lIa·lsIBrG'Ur%~Ftmll~el¥ilSfilflatti'ffi:r!J1.1I1!i_.li~lio.~al1l1~~~I t a
automatically adjust the number of "RH" records for each cross section.

8. Move the cursor down to "IT" record, and enter the number of time
iterations.

For the example problem, you enter 144 for the number of time iterations.

9. Move the cursor down to the "SO" record. Then click on the quick button
INri~eneraf;r.m:lf(!j'sfiiSlf.eelBle;._r_la.to generate the stage
discharge data template.

For the example problem, you follow the Macro Menu and choose "GENERA TE &
ADJUST 'SO' RECORD TEMPLATE," and then choose "USE THE VALUE
SPECIFIED IN 'IT' RECORD: 144." You can choose "ENTER NEW VALUE" to
specify a new value when needed.

1O. Move the cursor down to the "OS" record. Then click on the quick button
l.merafeli&lrifajisEmirlmllmi~llilaIr4.eeil£aj.emJJa_1 to generate the
sediment discharge data template.
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For the example problem, you follow the Macro Menu and choose "GENERATE &
ADJUST 'OS' RECORD TEMPLATE." Then choose "ENTER NEW NUMBER FOR
SEDIMENT DISCHARGE RECORDS," enter 1, and click "OK." Choose "USE
SPECIFIED NUMBER FOR "OS" RECORD: 1."

11. Move the cursor down to the "TM" record. Then click on the quick button

11.~e'ieiate~'iii·~1!I1Cl~ll£ate&.IEe'1lllitlie.I••'f.1II to generate the
temperature data template.

For the example problem, you follow the Macro Menu and choose "GENERATE &
ADJUST 'TM' RECORD TEMPLA TE." Then choose "ENTER NEW NUMBER FOR
TEMPERATURE RECORDS," enter 1, and click "OK." Choose "USE SPECIFIED
NUMBER FOR ''TM'' RECORD: 1."

12. Move the cursor down to the "SF" record. Then enter the number of size
fractions. Click on the quick button next to it to adjust the number of "SG"
records so that the number of "SG" records will match the number specified
in the "SF" record.

For the example problem, you enter 3.

STEP 2. ENTERING DATA

Once the general data layout is generated, the specified data for each cell in the
worksheet is entered according to the instruction for each cell. The instruction for
each cell in the worksheet is labeled in red (required data) or green (optional data).

• You can enter the data manually by following the instructions and entering
the corresponding data for each cell.

• Data from an existing spreadsheet file can also be imported by the cut and
paste facility in the Windows environment into the current worksheet.

STEP 3. GENERATING SRI-STARS INPUT FILE

The information that has been entered into the Quattro Pro worksheet needs to be
transferred into SRI-STARS in ut format. This is done b clickin on the button
1~!!i~eneram~e'QI~Sm~t;[Silt1ornmtiln"ut.lm.JJ~mis1tTcflt1i1lif!f.~.flllf~lliini;;.

For the example problem, when you click on the quick button, BRI-STARS input file
"BSTINPUT.DA T" is generated. The Ouattro Pro template file for 15 Bridge is provided in the
BRI-STARS package under the file name "15INPUT. WB2." You can compare your template
file "BSTINPUT. WB2" for the 15 bridge data with "15INPUT. WB2'.

10.3 NOTES

• Color codes used in the worksheet are as follows:

Red-data field description.
Blue-user instruction and tips.
Green-optional fields which may be left unchanged.
Black-fields which must be filled by the user.

• The macros are stored in pages MACRO and RESOURCES. Do not use
these pages for data editing.
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• If you create a block name, be sure not to overwrite existing block names.

• The default values provided in the template file "BSTEMPLT.WB2" are as
follows:

- English unit system.
- 10 cross sections having trapezoidal shape with main channel and left!

right floodplain.

- 50 data points for each cross section.

- 3 channel subsections.

- Manning roughness value of 0.025.
- Coefficients of contraction and expansion losses: 0.1 and 0.3.

- 3 stream tubes.

- 20 time iterations.

- 20 discretized water discharges.

- 20 discretized sediment discharges.

- Yang's Sediment transport equation.

- Active layer thickness multiplier of 50.

- 20 discretized water temperatures.
- 5 size fractions in the sand size range.
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11. LIST OF SRI-STARS EXAMPLES

The SRI-STARS package is supplied with a series of examples to demonstrate the
various options available in the model. The summary listing is given in table 4 with
the feature of each example.

Table 4. Examples for SRI·STARS and their features.

Example File Explanation and Features

EXMPLOO1.DAT • CSU Laboratory study

• Default Screen Plotting

• RH record to change n=0.02 to 0.04 behind piers

• IT record to set convergence limit to 0.0001 ft
• CL record to set CL=1

• NT record to set number of tubes to 4

EXMPLOO2.DAT • Dry Creek example with WSPRO input

• IT to set convergence criteria to 0.1 ft

• SF record to set single sediment size

• WB to use WSPRO data directly

EXMPLOO3.DAT • Hatchie Data (USGS)

• 6 sediment time steps within one hydraulic time step

• PV records

• PX record for generating cross section files

EXMPLOO4.DAT • CSU Laboratory Data

• PS, PE records for local pier scour

• PV records with zooming

• RH record to change n=0.02 to 0.04 behind piers

• CL set to 1 at U/S station

• IT to set level of accuracy in hydraulic computations

EXMPLOO5.DAT • CSU Data

• CM Comment record

• TM to set temperatures to 70°F

• Simulation of piers by altering x-sections

EXMPLOO6.DAT • Lower Tomillo study

• RH to show natural channel roughness distribution

• PR to control printout

• NF, SG, SD records for sediment routing in graded beds

EXMPLOO7.DAT • Red Fox

• Global positioning records

EXMPLOO8.DAT • Man-made channel

• RC records for multiple rating curves

• DD records for discretized discharges

EXMPLOO9.DAT • 15-Bridge data

• Global positioning

• Natural river data

EXMPL010.DAT • 15-Bridge data

• Date-Time function for variable time increment step
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12. SIMULATION OF 15 BRIDGE SITE

The California 15 Bridge Site is located at the Los Gatos Creek study reach
downstream from 1-5. Severe scouring happened in this study reach during the flood
on March 11, 1995. This study aims at estimating the contraction scour at the
California 15 bridge site during the flood by applying BRI·STARS with limited
available data. Figure 6 is the plan view of the study reach. The locations of the eight
cross sections and the high water edges measured by U.S. Geological Survey
(USGS) on March 20 and 21, 1995, are shown in this figure.

12.1 SELECTION OF SIMULATION DATA

The data needed for the numerical simulation of the study reach can be classified
into the following categories: i) channel geometry data, ii) roughness and energy
losses data, iii) hydrology data, and iv) sediment data.

The available channel geometry data are the channel cross sectional data measured
after the flood on March 20 and 21, 1995. There are four measured cross sections
(USGS sections nos. 9, 8, 7, and 6) at upstream of the bridge and four measured
cross sections (USGS sections nos. 3, 2, 1.5, and 1) at the downstream of the
bridge. Locations of the measured cross sections are shown in figure 6. The cross
section profiles of these measured sections are plotted in figures 7-14. It is assumed
that these cross sections represent the boundary conditions before the flood. There
are no cross sections measured at the bridge location. Two cross sections are
generated for the bridge contraction using USGS sections nos. 6 and 3 and the plan
view (figure 6) of the reach. These two generated cross sections are shown in
figures 15-16.

Figure 17 is the plan view of the location of cross sections used for simulation. In this
figure, cross sections nos. 12 and 13 are the two cross sections generated for the
bridge location; cross sections nos. 1-3 and 20-21 are propagated cross sections
extending the existing bottom slope using sections nos. 4 and 19 (USGS sections
nos. 9 and 1), respectively. Sections nos. 5, 7-8, 10, 15, and 18 are cross sections
interpolated using the corresponding upstream and downstream measured sections.
These cross sections are also listed in table 6.

The available hydrology data is the hydrography measured at D.W.A. Station, Los
Gatos Creek at Eldorado Avenue, shown in figure 18, and the high water surface
elevation shown in figure 19. From figure 18, it can be seen that the time duration of
the flood that occurred in March 11, 1995, was about one day. The average peak
flow discharge is about 20,000 cfs (cubic feet per second) according to the
estimation of J. Sterling Jones (Federal Highway Administration). From figure 19, it
can be seen that the high water surface elevation at station no. 19 (USGS station no.
1) is about 450.5 feet. The water surface elevation at downstream control station no.
1, which is 1000 feet downstream from section 19 (USGS station no. 1), was
determined to be 448.5 feet.

There are no available roughness and energy losses data. The Manning roughness
values in the main channel of the reach are about 0.04 according to J. Sterling
Jones' estimation. The local energy loss coefficients at bridge location are calibrated
according to the high water surface shown in figure 19.
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The bed material size was determined to be 0.2-0.3 millimeters according to J.
Sterling Jones. The inflowing sediment discharge into the study reach was
determined to be 300,000 tons per day (6,000 parts per million) through calibration.

d dTable 5. Measured, mterpo ated, an propaqate cross sections.

Cross Distance along USGS Measured Interpolated or
Section No. the Channel (ft) Section Propagated Section

1 . 3600.0 Propagated
2 3200.0 Propagated
3 2800.0 Propagated
4 2398.5 SEC-9
5 2187.0 Interpolated
6 1976.5 SEC-8
7 1740.0 Interpolated
8 1502.0 Interpolated
9 1265.5 SEC-7

10 1098.0 Interpolated
11 932.4 Interpolated
12 830.5 Interpolated
13 675.5 Interpolated
14 543.0 SEC-3
15 412.0 Interpolated
16 281.5 SEC-2
17 221.2 SEC-1.5
18 110.2 Interpolated
19 0.0 SEC-1
20 -5000.0 Propagated
21 -1000.0 Propaqated

12.2 NUMERICAL SIMULATION

An input data file is generated according to the information discussed above. A total
of 21 cross sections, including 8 USGS measured sections, 2 bridge sections, and
11 interpolated and propagated sections are used. The number of discretized stage
discharge values is 144, and the time increment is 0.00694 day (10 min). For the
sediment routing, Molinas and Wu formula is used to compute the transport rate in
the computations. The computed water surface and bottom profiles at time steps 1,
48, 96, and 144 are given in figure 20. In this figure, the variations of water surface
and bottom profiles versus time can be seen.

From the results computed by SRI-STARS with limited available data, severe
scouring can be seen since the bridge contraction during the one-day flood. At the
upstream of the bridge, the sediment was deposited at the initial phase of the
flooding because the water was blocked by the bridge contraction. This deposition
is reduced with the progress of time. Finally, It is changed to scouring from
deposition. The maximum scouring occurred at the bridge location. The maximum
scouring depth is about 9 feet at the bridge location.
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Figure 6. Plan view of the study reach at California 15 bridge.
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Figure 7. USGS measured cross section no. 9.
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Figure 8. USGS measured cross section no. 8.
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Figure 9. USGS measured cross section no. 7.
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Figure 10. USGS measured cross section no. 6.
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Figure 11. USGS measured cross section no. 3.
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Figure 12. USGS measured cross section no. 2.
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Figure 13. USGS measured cross section no. 1.5.
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Figure 14. USGS measured cross section no. 1.
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Figure 15. Generated cross section for bridge location at 830.3 ft.
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Figure 16. Generated cross section for bridge location at 675.5 f1.
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Figure 18. Hydrograph at D.W.A. station, Los Gatos Creek at Eldorado Avenue.
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